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KIRISH 

Delphi -  dasturiy vositasi:  Bu windows uchun mo’ljallangan dasturlash muhiti 

bo’lib, 1995  yilda BORLAND kompaniyasi guruhi dastur tuzuvchilari Chak 

(Chuck) va Denni (Danny)  tomonidan yaratilgan. Bu til o’zining keng qamrovli 

imkoniyatlariga egaligi bilan birga, boshqa dasturlash tillaridan o’zining ba’zi bir 

xususiyatlari bilan ajralib turadi. Delphi bu yuqori sifatga ega bo’lgan dasturlar 

yaratish vositasidir. Delphini yuklash uchun kamida  4MB tezkor xotiraga ega 

bo’lgan 386 kompyuter kerak bo’ladi. Lekin normal ishlash uchun kamida 8MB 

tezkor xotiraga ega bo’lgan 66MHz  li 486DX kompyuteri to’g`ri keladi.. Delphi 

dasturida yaratilgan uncha katta bo’lmagan dasturlar ixtiyoriy kompyuterlarda 

ishlay oladi. Boshqacha qilib aytganda ularga Delphi muhiti uchun zarur bo’lgan 

tezkor xotira va prostessorning tezligi talab qilinmaydi.Borland Delphi dasturining 

paydo bo’lishi dasturlashni rivojlantirish tarixida yorqin ko’rinish bo’ldi. Delphi 

ning vujudga kelishiga quyidagilar sabab bo’ldi; Delphi – dasturlashtirishda, 

dasturni tez ishlatishda foydalaniladigan dastur- lash tili. Delphi tili Object Pascal 

tiliga asoslangan dasturlash tili hisoblanadi. Hozirgi kunda Delphi  ning yangi 

loyihasi Borland Delphi 7 dasturchilarga ma’qul tushdi. Borland Delphi  bilan 

katta bazaga ega dasturlarni yaratish mumkin. Bu paketga turli xil ma’lumotlar, 

XML – hujjatlari, axborotlash tirish sistemalari va boshqalar kiritilgan. Delphi 7 

ning  asosiy xususiyati NET texnologiyasini qo’llab quvvatlaydi.. 

Delphi ning asosiy tashkil etuvchilari keltirilgan: 

1. Delphi ning asosiy oynasi. 

2. Formalar konstruktori (Form Designer)  

3. Ob’ektlar inspektori (Object Inspector) 

4. Ob’ektlar daraxti (Object TreeView) 

5. Dastur matni muharriri (Code Editor)  

6. Dastur matniga yo’l ko’rsatuvchi oynasi (Code Explorer) 
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Buyruq menyusi: Delphining  menyu satridan quyidagilar jоy оlgan: File, Edit, 

Search, View, Project, Run, Component, Database, Tools, Help.  

Bu•larning barchasida оst menyular mavjuddir. File ning оst menyusida bir necha  

buyruqlar bo’lib ular yordamida yangi prоyekt, fоrmalarni оchish va ularni saqlash 

mumkin. Shu bilan birgalikda оchilgan prоyektni yopish, Delphi dan chiqish va 

shularga o’хshash fayllar bilan ishlash imkоniyatlari bоr: 

Edit menyusi оst menyudan fоydalanib kоdlarni tahrirlash, umuman kоdlar sirtida 

turli хil amallarni bajarish mumkin; 

View yordamida esa Delphi ishchi muhiti  ko’rinishini o’zgartirish mumkin; 

Run menyusi yordamida dasturni ishga tushirishni turli yo’llari amalga оshiriladi; 

Database menyusida ma`lumоtlar ba’zasini tashkil qilish mumkin; 

Help menyusi esa Delphi va unda dasturlash  haqidagi barcha ma’lumоtlarni оlish 

imkоniyatini yaratadi.   

Buyruqlar tugmachasi: Buyruqlar tugmachasi yordamida yangi fоrmalar 

yaratish, mavjud faylni оchish, dasturni saqlash, yangi fоrma yaratish va shunga 

o’хshash amallar tez bajariladi. 

Kоmpоnentlar palitrasi: Bu yerda standart yoki dasturchilar tоmоnidan yaratilgan 

kоmpоnentlar mavjud bo’lib, ulardan tez va sifatli dasturlar yaratishda 

fоydalaniladi. 

   Object Inspector оynasi: Object Inspector оynasi quyidagi оb’yektlarning 

hоlatini o’zgartiradi: fоrmalar, buyruqlar tugmachasi, kоdlar maydоni va 

bоshqalar. 

    Dastur fоrmasi: Dastur tuzishda ishlatiladigan barcha kоmpоnentlar dastur 

fоrmasiga jоylanadi va ana shu yerdan ularga o’zgartirish kiritilishi mumkin. 

Dastur ishga tushirilgandan so’ng, barcha amallar dastur fоrmasi yordamida 

bajariladi. 

    Dastur kоdi:  Dastur kоdi fоrma оrqasiga yashiringan bo’lib, u yerga dastur 

matnlari kiritiladi. U оynaga F12 yoki Ctrl+F12 tugmalari yordamida o’tish 

mumkin.  
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   Delphi kоdlar muhitida dastur buyruqlarini kiritish va ularni qayta ishlash 

mumkin. Shuni ham ta’kidlash lоzimki, Delphi  kоdlar muhiti avtоmatik tarzda           

Object Pascal dasturlash tilidagi kalit so’zlarni (begin, end, procedure, const, var 

va bоsh.)  qalin harflar bilan  belgilaydi.  

   Ma`lumоt yozilgan satr(dastur izоhi)ni belgilash uchun  figurali qavslardan 

fоydalaniladi. Qavs оchilsa undan keyin turgan kоdlar ko’rinishi o’zgaradi. Kerakli 

jоyda qavs berkitilsa ko’rinishi o’zgargan kоdlar faqat qavs оralig’idagina qоladi 

va dastur ishlash jarayonida shu оraliq ishlatilmaydi. 

    Delphi kоdlar muhitining imkоniyatlaridan yana biri shuki, u yerga birоr 

funksiyani  masalan: «StrToFloat» ni yozib, qavs оchsak satr оstida kichik оyna 

hоsil bo’ladi. Bu оynada qavs ichidagi o’zgaruvchi tipi ko’rsatilgan bo’ladi, yoki 

birоr оperatоrni  masalan: Label1 ni yozib nuqta qo’yilsa  satr оstida nuqtadan 

keyinga yozish mumkin bo’lgan оperatоrlar ro’yhati chiqadi va ulardan  

kerakligini tanlab qo’yishimiz mumkin. 

Windows uchun dasturlash va komponentalar texnologiyasi. 

 Masalalarni echish uchun ob’ektga yo’naltirilgan usul. 

 Komponentalar texnologiyasiga asoslangan ilovalarni tez yaratishning vizual 

muhitlari. 

 Interpritastiyadan emas, kompilyastiyadan foydalanish. Bu shundan iboratki, 

interpretator bilan ishlashga qaraganda kompilyator bilan ishlash tezligi o’n 

martalab ustunlikka ega bo’ladi. 

 Universal usullar yordamida ma’lumotlar bazasi bilan ishlash 

imkoniyatlarining mavjudligi. 
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                           I BOB. Ma`lumotlar bazasi haqida 

M a ‘ l u m o t l a r   b a z a s i – bu ma’lum bir predmet  sohasiga oid tizim 

lastirilgan(strukturalashtirilgan) ma’lumotlarning nomlangan to’plamidir.  MB - bu 

ma’lum berilgan aniq bir strukturaga ega bo’lgan ma’lumotlarni o’z ichiga oluvchi 

maxsus formatga ega bo’lgan fayldir. Ma’lumotlarni strukturalashtirish - bu 

shunchaki ma’lumotlarni tasvirlashda qandaydir moslikni kiritish usulidir. Odatda 

MB ma’lum bir ob’ekt sohasini ifodalaydi va  uning ma’lumotlarni o’z ichiga 

oladi, ularni saqlaydi va foydalanuvchiga ma’lumotlarni qayta ishlashda undan 

foydalanish imkonini yaratib beradi. 

Ma’lumotlar bazasi tushunchasi maydon, yozuv, fayl (jadval) kabi 

elementlar bilan chambarchas bog`liq. 

Maydon-bu ma’lumotlarni mantiqiy tashkil etishni elementar birligi bo’lib, u 

axborotni eng kichik va bo’linmas birligi bo’lgan rekvizitga mos keladi. Maydonni 

tasvirlash uchun quyidagi tavsiflardan foydalaniladi: 

1. Maydo

n nomi, masalan, familiyasi, ismi, tug`ilgan sana, lavozimi, ish staji, 

mutaxassisligi. 

2. Maydo

n turi, masalan, son (chislovoy), simvol (simvolnыy), sana / vaqt 

(data/vremya), mantiqiy (logicheskiy). 

3. Maydo

n uzunligi (o’lchami), masalan, eng ko’p simvollar sig`imi;  

4. Maydo

n aniqligi, (son tipidagi ma’lumotlar uchun) masalan, sonning o’nlik kasr 

qismini aks ettirish uchun o’nlik raqamdan to’rtta. 

Yozuv –bu mantiqiy bog`langan maydonlar to’plami. Yozuv tuzilishi uchun 

uning tarkibiga kiruvchi maydonlar tarkibi va joylashishi ketma-ketligi bilan 
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aniqlanib, ularni har biri ichida elementar yozuvlarning nusxasi deb ataladi. 

Yozuv ob’ektning biror bir elementi haqida to’liq ma’lumotni ifodalaydi. 

Fayl (jadval) -bu bir xil tuzilmaga ega bo’lgan yozuvning nusxalar 

to’plamidir. U o’zicha har bir maydonda qiymatga ega. 

Misol 1. STUDENT faylidagi (jadvalidagi) yozuvlarning mantiqiy 

strukturasini tavsiflashga doir misol 4-rasmda ko’rsatilgan. Bu faylga 2-rasmda 

ko’rsatilga ma’lumotlar joylashtirilgan. STUDENT faylidagi yozuvning tuzilishi 

chiziqli bo’lib, u o’zgarmas uzunlikdagi yozuvlardan iborat. Yozuv maydonlari 

takrorlanuvchi qiymatlar guruhiga ega emas. Maydon qiymatiga murojaat uning 

nomeri bo’yicha amalga oshiriladi.  

Fayl nomi  STUDENT 

Maydon  

Kalit 

belgisi 

Maydon formati 

Nomni 

belgilash 

To’liq nomlanish 

(rekvizit) 

Tip Uzunligi Aniqligi 

Nomer Talaba reyting 

daftarchasi nomeri 

* simvol 10  

Familiya Talaba familiyasi  simvol 10  

Ismi Talaba ismi  simvol 8  

Ota.ismi Talaba otasi ismi  simvol 10  

T_kun Talabaning tug`ilgan 

sanasi 

 Sana 8  

O’rta_baho Talabaning o’rtacha 

bahosi 

 Son 

 

3 2 

1-rasm. STUDENT faylidagi yozuvlar mantiqiy  tuzilishini tavsifi 

Har bir MB jadvali o’zining birlamchi kalitiga ega bo’lishi mumkin. Birlamchi 

kalit deganda yozuvlar qaytarilmasligini ta’minlovchi maydon (polya) yoki 
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maydonlar guruxi tushiniladi. Birlamchi kalit sifatida ishlatiladigan maydon yoki 

maydonlar guruxi, bir xil yozuvga ega bo’lmaslik shartini bajarishi kerak. 

Masalan, yuqorida keltirilgan 1-rasmdagi jadvaldagi maydonlardan faqat reyting 

daftarchasi nomeri birlamchi kalit bo’la oladi. Boshqa maydonlarida  bir  xil  

yozuvlar takrorlanishi mumkin. Shu sabab ular birlamchi kalit bo’laolmaydi. 

Birlamchi kalit qisqa va sonli maydonlardan tashkil topishi maqsadga muvofiqdir. 

MB jadvaliga birlamchi kalitni kiritishdan maqsad, jadvaldagi ma’lumotlarni 

izlash, tartiblashtirish va tanlab olishda qulaylikni beradi. Birlamchi kalit kiritish 

yoki kiritmaslik foydalanuvchi tamonidan MB jadvali strukturasini tashkil 

qilishda aniqlanadi. 

 M a ‘ l u m o t l a r   b a z a s i n i   b o sh q a r i sh  t i z i m i – bu ma’lumotlar 

bazasini yaratish,  ularni  dolzarb holatini ta’minlash va undagi zarur axborotni 

topish ishlarini tashkil etish uchun mo’ljallangan dasturlar majmui va til 

vositasidir. 

  1.2  Ma’lumotlarning relyastion bazasi - bu o’zaro bog`langan 

munosabatlar, ya’ni jadvallar to’plamidir. Har qanday munosabat (jadval) 

kompyuterlarning xotirasida fayl ko’rinishda joylashtiriladi. Ularning orasida 

quyidagi moslik mavjud: 

Fayl Jadval Munosabat Mazmuni 

Yozuv 

Maydon 

Satr 

Ustun 

kortej 

atribut 

mazmunning nusxasi 

atribut 

Jadval hamma uchun juda qulay bo’lishi bilan bir qatorda ma’lumotlarni 

manipulyastiya qilishning asosiy uch operastiyasini bajarish uchun noqulaydir:, 

ya’ni tartiblash, indekslarning qiymatlari bo’yicha guruhlash va daraxt 

ko’rinishidagi parametrlar bilan ishlash.  

Ma’lumotlarning relyastion bazasidagi munosabatlar ustida bajariladigan 

asosiy operastiyalar sakkizta bo’lib, ular quyidagilardan iborat: 
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-to’plamlar ustidagi ananaviy (tradistion) operastiyalar, ya’ni to’plamlarning 

birlashmasi (yig`indisi), kesishmasi (ko’paytmasi), to’ldiruvchisi (ayirmasi), dekart 

ko’paytmasi, bo’lishmasi; 

-maxsus relyastion operastiyalar, ya’ni proekstiyalash, bog`lanish (qo’shilish), 

birlashtirish (ulab qo’yish) va tanlash.  

Agar  MBda  ishtirok etadigan  jadvallar  o’zaro  bog’langan  bo’lsa,  bunday  MB 

ni  relatsion  turdagi MB deb atash  qabul qilingan.  Bunda jadvallarni  o’zaro  

bog’lash  uchun  umumiy  xususiyatga  ega   bo’lgan  unikal  maydon  tushunchasi  

kiritilgan  ushbu  tushuncha  bazan  MBning  kalitli  maydoni deb ham  ataladi. 

Jadvalning  bunday  bog’lanishi  bog’lanish  sxemasi  deyiladi.  MB  doimo  

o’zgarib  turadi: unga  yangi yozuvlar, borlariga  esa   yangi  elementlar  

qo’shiladi. Relatsion  ma`lumotlar  bazasi  quyidagi  parametrlar  bilan  

baholanadi.  

   1.Soddalik                                                                           4. Maxfiylik. 

    2. Moslanuvchanlik.                                                           5.Bog’liqlik. 

    3. Aniqlilik.                                                                         6.Bog’liqsizlik. 

         Ma’lumotlar bazasi jadvallari orasidagi relyastion bog`lanish.

 MBing ikki va undan ortiq jadvallari orasida biri ikkinchisiga bog`liq 

bo’lishi mumkin. Agar ikkinchi jadval birinchi jadvalga qaram bo’lsa birinchi 

jadvalga bosh jadval, ikkinchi jadvalga esa qaram jadval deyiladi. Bosh jadvaldagi 

bitta yozuvga qaram jadvalda unga mos bir necha yozuv mavjud bo’lishi mumkin.  

         MB jadvallari orasida uchta har xil aloqa bo’lishi mumkin: “bitta-ko’pga”; 

“bitta-bittaga”; “ko’p-ko’pga”. 

“Bitta-bittaga” bog`lanish. “Bitta-bittaga” bog`lanish bo’ladi, qachonki 

bosh jadvaldagi bitta yozuv qaram jadvaldagi faqat bitta yozuvga aloqasi bo’lsa. 

Misol. “O’qituvchilar” jadvali                   “O’qituvchilar haqida ma’lumotnoma”  

jadvali                
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№ F.I.O. Lavozimi Kafedra  № Tug`il.yili

. 

bolasi 

1 Jalolov O. Dostent Matematika  1 1981 3 

2 Hayotov X. Katta 

o’qit. 

Informatika  2 1982 1 

3 RustamovA. Assistent Fizika  3 1988 2 

     “Birga-bir” bog`lanish qattiq yoki yumshoq bo’lishi mumkin. Agar bosh 

jadvaldagi bitta yozuvga qaram jadvaldan hamma vaqt faqat bitta yozuv to’g`ri 

kelsa qattiq bog`lanish bo’ladi. Agar bosh jadvaldagi bitta yozuvga qaram jadvalda 

bitta yozuv bo’lish yoki bo’lmaslik sharti bo’lsa u holda bog`lanish yumshoq 

bo’ladi. Bugungi kunda bir necha yuz ming tashkilotlar  ma’lumotlar bazasi 

tizimidan foydalanishadi, bu shunday jarayonki, kompyuterlashtirish tizimida 

ma’lumotlarniyozish va saqlash demakdir.  

 “Bitta-ko’pga” bog`lanish. “Bitta-ko’pga” bog`lanish bo’ladi, qachonki 

bosh jadvaldagi bitta yozuv qaram jadvaldagi bir necha yozuvga aloqasi bo’lsa.    

Misol.   “Fakultetlar” jadvali                          “Studentlar”jadvali 

№ Fakultetlar nomi Talabala

r soni 

 Yuqori ball 

olgan talabalar 

Fakul. 

nomeri 

Ball 

1 Fizika-matematika  500  Sirojov P. 1 100 

2 Sport_fak   700  Raxmonqulov 

M. 

1 95 

3 Pedagogika 1000  Turayeva M. 1 93 

4 Harbiy_fak  600  Norova D. 2 100 

     Ibrohimov M. 2 97 
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    Bozorov S. 4 98 

    Murodova Sh. 4 93 

Relyastion MB uchun “bitta-ko’pga”bog`lanish holati eng ko’p ishlatiladi. 

 “Ko’p-ko’pga” bog`lanish. “Ko’p-ko’pga” bog`lanish quyidagi hollarda 

bo’lishi mumkin. 

a) bosh jadvaldagi yozuvga qaram jadvalda bittadan ortiq yozuv to’g`ri 

kelsa. 

b) qaram jadvaldagi yozuvga bosh jadvalda bittadan ortiq yozuv to’g`ri 

kelsa. 
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 Misol.   “Guruhlar va predmetlar”  jadvali    “O’qituvchilar”     

jadvali 

1.3.SQL so’rovlar tili va uning buyruqlari -SQL (Structured Query Language) 

tili 

strukturalashgan so’rov tili deyilib, u ma’lumotlar bazasi bilan a’loqa o’rnatish 

uchun xizmat qiladi. SQL tili 70 yillar oxirida IBM firmasi tomonidan Sytem r 

nomli ma’lumotlar bazasini boshqarish tizimining tajribaviy loyihasini  ishlab 

chiqish doirasida yaratildi. Keyinchalik IBM firmasi tomonidan Sytem r ga yaqin 

Guruh Fan nomi O’qit. 

nomeri 

 O’qit. 

nomeri 

O’qit. 

I. F. 

Kafedra 

nomi 

22-03 Programmalash 10  10 Sobirov  AT 

4-02 Axborot 

texnologiyalari 

10  12 Karimov R Ximiya 

3r-03 Mexanika 13  62 Ikramov  Tarix 

7-02 Falsafa 62  78 Naimov T. Fizika 

18-03 Tarix 62  85 Zoirov S. EI 

Guruh Fan nomi O’qit. 

nomeri 

 O’qit. 

nomeri 

O’qit. 

I. F. 

Kafedra 

nomi 

22-03 Programmalash 10  10 Sobirov  AT 

4-02 Axborot 

texnologiyalari 

10  12 Karimov R Ximiya 

3r-03 Mexanika 13  62 Ikramov  Tarix 

7-02 Falsafa 62  78 Naimov T. Fizika 

18-03 Tarix 62  85 Zoirov S. EI 
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bo’lgan yana ikkita sistema - SQL/DS i DB2 sistemalari ishlab chiqildi. Bu tilning 

xalqoro standarti 1986 yili ishlab chiqildi va u 1989 yilga kelib yanada 

kengaytirildi, lekin uning to’liq xalqaro standarti 1992 yil qabul qilindi. 1995 yilga 

kelib SQL92 standarti yangi komponentalar bilan to’ldirildi. Birinchi bo’lib SQL 

dan foydalanish  Oracle MBBTda ishlatildi. Hozirgi kunda ko’pgina ishlab 

chiqilgan relyastion ma’lumotlar bazasini boshqarish tizimlari (MBBT) SQL92 

standartini ishlatmoqda. 

SQL quyidagi komponentalarni o’z ichiga oladi: 

 -adminstrativ ma’lumotlar vositasi; 

 -tranzakstiyalar balan boshqarish vositasi; 

 -DLL (Data Definition Language) ma’lumotlarni aniqlash tili; 

 -DML (Data Manipulation Language) ma’lumotlar ustida manipulyastiya 

qilish (murakkab harakatlar bajarish) tili; 

 -DQL (Data Query Language) ma’lumotlar bazasiga so’rovlar tili. 

So’rovlar tili - foydalanuvchi tamonidan berilgan kriteriyalar asosida kerakli 

ma’lumotlarni ma’lumotlar bazasidan tanlab olishni tashkil etib beradi. 

 SQL- bu relyatsion bazalardagi ma’lumotlarni  shakllantirish va ularni 

qo’llab-quvvatlash uchun maxsus yaratilgan tildir. SQL  umum yo’nalishga 

mo’ljal- langan dasturiy til emas,  lekin ayrim kuchli vositalar uning tarkibida 

mujas-samlashgan. Ma’lumotlarni aniqlash tili (DDL) – SQL tilining bu qismi 

ma’lumotlar bazasini yaratish,  uning strukturasini o’zgartirish va  unga ehtiyoj 

qolmaganda uni o’chirish imkonini beradi. Bu elementlar tarkibiga  jadvallar, 

sxemalar, kataloglar, klasterlar va boshqalar kiritilishi mukin. Bu bo’limda 

konteynerli irarxiya  to’g`risida fikr yuritilib, u yuqoridagi elementlarni bir-biri 

bilan bog`lab, ma’lumotlar bazasi elementlari yordamida bajariladigan buyruqlarni 

ko’rib chiqadi. 
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Ma’lumotlar bazasining jadvallari massiv ko’rinishida bo’lib,  ular satr va 

ustunlardan iborat bo’ladi. Jadvalni SQL tilining CREATE TABLE ( jadvalni 

tuzish) buyrug`i bilan tuzish mumkin. Buyruqda har bir ustunning nomini va 

ma’lumot turini ko’rsatib o’tish kerak. Jadval tuzilgandan keyin uni to’ldirishga 

kirishish mumkin. Ma’lumotlarni kiritish - bu DML va DDL tilining vazifasiga 

kiradi. CREATE- bu buyruq SQL  ob’ektining bir necha turlarini, shu bilan birga 

sxemalarni, domenlarni, jadvallar va tasavvurlarni yaratishi mumkin.  CREATE 

SCHEMA  (sxemani tuzish) operatori bilan sxemani tuzish, uning egasini aniqlash 

mumkin. Misol qilib bir operator ko’rinishini ko’rsatib o’tamiz: 

CREATE SCHEMA SALES 

  AUTHORIZATION SALES_MGR 

             DEFAULT CHARACTER SET ASCII_FULL ; 

 CREATE DOMAIN  (domen tuzish) operatori yordamida ustunda mavjud 

bo’lishi mumkin bo’lgan ma’lumotlarga cheklashlar qo’yiladi. Bu cheklashlar 

orqali domenda mavjud bo’lishi mumkin va mumkin bo’lmagan ob’ektlar 

belgilanadi. Sxema o’rnatilgandn keyin domenni tuzish mumkin. Misol: 

CREATE DOMAIN AGE AS INTEGER                   

  CHECK  (AGE > 20)  ; 

 Jadvallar CREATE TABLE operatori yordamida, tasavvur esa CREATE 

VIEW  yordamida tuziladi. CREATE TABLE yordamida tuzilayotgan yangi jadval  

o’sha operatorning ustunida kerakli bo’lgan cheklashlar ham qo’yish mumkin. 

Ba’zi paytlarda cheklashlarni butun sxemaga ham qo’yish to’g`ri keladi. Bunday 

vaziyatlarda CREATE ASSERTION operator yordamida  amalga oshiriladi. 

Bundan tashqari yana CREATE CHARACTER SET, CREATE COLLATION va 

CREATE TRANSLATION  operatorlari mavjud.  

   ALTER -jadval har doim ham siz uni tuzganingiz bo’yicha qolavermaydi. Siz 

uni ishlatishni boshlaganingizda u yerdagi kerak ma’lumotlarning hammasi ham 
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ko’rinmasligi mumkin. Javdalni o’zgartirish, qo’shish yoki ustunni  yo’qotish 

uchun ALTER TABLE (jadvalni o’zgartirish) buyrug`ini ishlatish mumkin.  

  DROP- ma’lumotlar bazasidan jadvalni yo’qotish juda oson. Bunda faqat biz 

DROP TABLE <jadval_nomi> buyrug`ini ishlatishimiz mumkin. Buning 

natijasida shu jadvalning barcha ma’lumotlari o’chiriladi. 

                       2.  MB bilan ishlash uchun Delphi komponentlari. 

Delphi dasturlash tilida ma`lumotlar bazasi bilan ishlaydigan komponentalar 

uch guruhga bo`linadi. Ular quyidagilar: 

1 MB bilan ishlash uchun vizual bo’lmagan komponentalar. Vizual bo’lmagan 

komponentalar ilovalar bilan MB jadvalini bog`lashga xizmat qiladi. Bu 

komponentalar Data Access kompanentalar palitrasida joylashgan. 

  2 MB bilan ishlash uchun vizual komponentalar. Delphi vizual komponentalari 

ma’lumotlar to’plami yozuvlarini (masalan, komponenta TDBGrid) akslantirish 

uchun va foydalanuvchiga qulay interfeys yaratish uchun ishlatiladi. Bu 

komponentalir Data Controls komponentalar palitrasida joylashgan. 

  3 Hisobotlar tuzish uchun komponentalar. Bu komponentalar 20 dan ortiq bo’lib 

ular Qreport komponentalar politrasida joylashgan bo’lib, hisobotlarni tuzish 

uchun ishlatiladi. 

 MB tayyor ilovasi bilan ishlash uchun vositalarning umumiy tarkibi 

quyidagi sxemada keltirilgan 

 

 

 

 

 

Malumotlar bazasi 

BDE 
 

 
MBda ishlash uchun vizual bo`lmagan komponentalar 

 

MBda ishlash uchun vizual bo`lgan komponentalar 

 

Ilova 
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MB bilan ishlash uchun vizual bo’lmagan asosiy komponentlar haqida 

ma’lumotlar 

Komponent Vazifasi 

Tsession MB bilan aloqa o’rnatish seansi bo’lib, MB ochishda, 

yopishda va uni parametrli boshqarishda ishlatiladi.  

Tdatabase 
MB. Bu komponent himoyalashgan MB bilan birlashtirish 

jarayonini boshqarish uchun xizmat qiladi. 

Tdatasource 

 

Ma’lumotlar manbai. Ma’lumotlarga murojaat qilish 

komponentlari bilan ma’lumotlarni aks ettirish komponentalar 

o’rtasida bog`lovchi element vazifasini bajaradi 

 TDataSet  Klientlar ma’lumotlari to’plamiga, ma’lumotlarga MBni 

mashinasidan foydalanmasdan murojaat qilish vositasi sifatida 

ishlatiladi. MB bilan ishlashda xossa va metodlarni aniqlaydi.  

 Ttable 

 

MBning  jadvaliga (fayliga) kirish vosita sifatida xizmat 

qiladi 

Tquery 
So’rov. Ma’lumotlar jadvalini SQL tili yordamida tanlab olish 

imkonini beradi  

TIndex Dets MB jadvali indekslari haqida ma’lumotni beradi 

TField Dets MB jadvali maydonlari haqida ma’lumotni beradi 

TBatch Move    Bir MB to’plamini boshqasiga ko’chirishda ishlatiladi 
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   MB bilan ishlash uchun vizual komponentlar haqida ma’lumotlar 

Komponent Vazifasi 

TDBtext  Ma’lumotlar to’plami maydonini joriy yozuvini 

ko’rsatadi 

TDBEDIT Joriy yozuvni ko’rish va maydon qiymatlarini 

o’zgartirishni ta’minlaydi. (tahrirlash) 

TDBCheckBox Mantiqiy turga (Boolean) ega bo’lgan 

maydonlarning joriy yozuvini ko’rish va uning 

qiymatlarini tahrirlashni ta’minlaydi. 

 

TDBMenu Menyu-maydon(posl komentariya) qiymatlarini 

matn muharriri rejimida ko’rish va o’zgartirishni 

ta’minlaydi 

TDBGrid MB jadvali. Ma’lumotlar to’plamini jadval 

ko’rinishida chiqarishni ta’minlaydi. 

TDBNavigator MB navigatori. MB yozuvlarini engillashtirishni 

ta’minlaydi. Shuningek yozuvlarni qo’yish, olib 

tanlash va tahrirlash imkonini beradi. 

TDBChart Ma’lumotlarni grafik ko’rinishida tasvirlashda 

ishlatiladi. 

 2.1 Delphi tarkibiga kiruvchi M a ‘ l u m o t l a r   b a z a s i ni boshqarishda 

ishlatiladigan ilovalarni tuzish va ishlatish vositalariga quyidagilar kiradi: 
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  -BDE (Borland Datebase Engine). Borland ma’lumotlar ba’zasi  mashinasi. 

Uning tarkibiga dasturlar to’plami kiritilgan bo’lib, ular lokal va klient server 

toifasining MBga murojaat qilishni va undan foydalanishni tashkil qilib beradi. 

    

 

 

 

 

 

 

   -SQL LINKS. Boshqa MBBT bilan (Masalan, SysBase, Oracl, MsSQL Server) 

ishlash uchun drayverlar. Delphi tizimi Paradox va Dbase MBBT lari uchun SQLni 

ishlatmaydi, BDE yordamda bajaradi.   

    -DBE administrator - bu utilita bo’lib MBga psevdonimlar, parametrlar va MB  

o’rnatish uchun ishlatiladi. Delphida tuzilgan ilova yordamida MB bilan ishlash 

vaqtida Mbdan foydalanish uning psevdonimi bo’yicha amalga oshiriladi. 

   -DataBase Destop (DBD). Mbni ko’rish, taxrirlash va tashkil qilish uchun 

maxsus vosita (utilita). Bu utilita asosan Paradox va Dbase MBBT uchun uning 

jadvallari  

bilan ishlashga yo’naltirilgan bo’lib, ayrim hollarda boshqa tashqi MBBT 

jadvallari bilan ishlashda ham foydalaniladi. Ilovalarning o’zaro bog`lanishining 

umumiy modeli quyidagi sxemada berilgan. otlar bazasida ishlash 

 -DataBase Explorer (SQL Explorer). MB psevdonimi, konfigurastiyasi va 

strukturasini ko’rish, hamda MB jadvaliga so’rov berish utilitalarini o’z ichiga 

oladi.  

Ma`lum uchun ilova 

BDE 
DataBase 

DesTop 

Lokal MB 
Paradox,Dbase 

BDE  

administranor 

SQL 

Lincs 

Boshqa MBBT(Oracl,SyBase, 

MsSQL Server,Interbase) 
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   -SQL manitor. SQL so’rovlarini bajarish vositasi. 

   -Visual Query Builder. Delphi tarkibiga kiruvchi vosita bo’lib, SQL –

so’rovlarini avtomatlashtirishni tashkil etadi. 

   -Data Dictionary –ma’lumotlar lug`ati. MB jadvali maydonlari atributini 

saqlaydigan vosita. 

BDE bo’limi – bir nechta komponentalardan tashkil topib,ular quyidagilar: 

Table – ma’lumotlar omborini (faylni) bog`lash. TTable ob’ekti ma’lumotlar 

omboridagi mavjud jadval bilan mulokot o’rnatish uchun xizmat qiladi. TTable 

ixtiyoriy tipdagi (FoxPro, ODBC, SQL ...) ma’lumotlar omborining har bir 

yozuviga va maydoniga to’g`ridan-to’g`ri murojaat qila oladi. Bu komponent 

shuningdek, alohida hisobotlar bilan ham muloqot o’rnata oladi. TTABLE 

ob’ektidan foydalanishdan oldin unga ma’lumotlar ombori alyasini ulash kerak, 

ya’ni shu komponentning DatabaseName xususiyatida chiqadigan ro’yxatdan 

kerakli alyasni tanlash va TableName xususiyatidagi ro’yxatdan kerakli jadval 

nomini tanlash kerak. TTABLE ob’ektini faollashtirish uchun Active xususiyati 

qiymatini true ga o’tkazish kerak.  

Query – ma’lumotlar omboridagi yozuvlarni boshqarish. 

 StoredProc – serverdan ma’lumotlar omborini yuklash. 

 Database – yagona ma’lumotlar omborini bog`lash 

Delphida ilova yordamida MBdan foydalanish uchun           Ilova=> BDE=> MB 

ketma-ketligi bajariladi. Bu shuni bildiradiki har qanday MBga ilovadan murojaat 

qilinganda uning aniq adresi BDEga uzatiladi. BDE o’zining maxsus funksiyalarini 

MB bilan bog`lanishda ishlatadi. BDE aniq bir MB bilan ishlaganda quyidagilarni 

bilishi kerak. 

 -MB qaysi joyda joylashganligini;  
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 -MB parametrlari haqidagi ma’lumotni. 

 MB parametrlari va uning joylashishi MB psevdonimida aniqlanadi. 

Psevdonim - MB ga berilgan biror nom bo’lib MBga mantiqiy murojaat qilinganda 

ishlatiladi. 

 MB psevdonimi BDE adminisrator utilitasi yordamida aniqlanadi.   MBning 

har bir jadvali uchun fayl tuziladi. Xuddi shunday jadval indekslari va memo 

maydonlari uchun maxsus fayllar tuziladi. MBga dastur va utilitalardan murojaat 

qilinish MBning psevdonimidan amalga oshiriladi. Psevdonim BDE administrator 

utilitasi yordamida aniqlanadi. Psevdonim - biror bir nom bo’lib MBga Delphi 

komponenti ilovalari (masalan Ttable va Tquery) tamonidan mantiqiy murojaat 

qilishda ishlatiladi. Aytaylik biz tashkil qilishimiz kerak bo’lgan MB 

“C:\PROBA\” katologida joylashsin. Biz tashkil qiladigan psevdonim nomi 

aytaylik “Proba” bo’lsin. BDE administrator utilitasini ishga tushiramiz. Asosiy 

menyudan Object/New buruqlarini tanlaymiz. Hosil bo’lgan darchadan tuziladigan 

MB turini aniqlash uchun “Standart” parametrini o’zgartirmasdan Ok tugmasini 

bosamiz. Chap oynada (MB administratori oynasida) biz “Standart1” nomini 

ko’ramiz va uni “Proba”ga o’zgartiramiz. O`ng oynada MB parametrlari berilgan, 

u yerda faqat Path (yo’l) o’zgartiriliadi. Bu parametr MB katalogiga yo’lni 

ko’rsatadi. Path nomini ko’rsatib, o’ng darchadan uch nuqtali tugmani va keyin 

chap oynadan “Proba”ni tanlab Ok tugmasini bosamiz. MB uchun aniqlangan 

psevdonimni saqlash uchun chap oynaga kelib, sichqoncha o’ng tugmasini 

chiqillatib dialog oynasidan “Apply” elementini tanlaymiz va Ok tugmasini 

bosamiz. Keyin esa BDE administratoridan chiqamiz. 

 MBni psevdonimini tuzishni yanada chuqurroq ko’rib chiqaylik. Uning 

algoritmi  quyidacha: 

  1.BDE administrator utilitasi ishga tushiriladi. 

  2.Menyudan Object=>New buyrug`i beriladi. 
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  3.Darchadan Standart turi o’zgartirilmasdan Ok tugmasi bosiladi. 

 

4.Chap oynadan Standart1 nomi yangi psevdonim nomiga o’zgartiriladi. 

 5.O’ng oynada Path qatoriga o’tilib, uch nuqtali tugmacha va keyin Ok bosiladi.  

 6.Menyudan Object=>Apply=>Ok buyrug`i beriladi. 

 7.BDE administratordan chiqiladi. 

  2.2 ADO, DataAccess, DataControl komponentalari va undan foydalanish 

 TADOTABLE ob’ekti ham xuddi TTABLE ob’ekti kabi ma’lumotlar 

omboridagi biror jadvalga bog`lanish va unga murojaat qilish uchun xizmat qiladi. 

Bu ob’ektdan asosan MSAccess ma’lumotlar omborini boshqarish tizimida 

yaratilgan omborlar bilan ishlashga mo’ljallangan. Bu ob’ekt asosan 

TADOconnection ob’ekti bilan birga qo’llanilib, TADOconnection ma’lumotlar 

omboriga ulanadi. Shundan so’ng bir yoki bir nechta TAdotable ob’ektlari 

Connection xususiyati yordamida TADOconnectionga ulanadi va TableName 

xususiyati yordamida kerakli jadvalga ulanadi. Ob’ektni faollashtirish uchun 

Active xususiyati qiymatini true ga o’tkazish kerak. Bu ob’ekt yordamida 

ma’lumotlar omboridan ma’lumotlarni biror filtr yordamida ajratib olish mumkin. 

Data Controls- (ma’lumotlar bilan bog`liq elementlarni boshqarish) sahifasida 

asosan vizual komponentalar bo’lib ularga ma’lumotlar bilan bog`liq 

komponentalar deyiladi.  

 DBGrid – ma’lumotlar omboridagi yozuvlarni jadval ko’rinishida chiqarish. 

Jadvalni namoish etish komponentasi bo’lib hisoblanadi.TDBGRID ob’ekti 
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ma’lumotlar omboridagi hisobotlar, jadvollar va so’rovlardagi ma’lumotlarni 

jadval ko’rinishida namoyish etish uchun qo’llanadi. Bu ob’ekt yordamida 

ma’lumotlar omboridagi yozuvlarni namoyish qilish, tahrirlash va o’zgartirish 

mumkin. Kiritilgan o’zgartirishlar joriy yozuv ustida boradi va bu o’zgarishlar 

faqat siz boshqa yozuvga o’tganingizda, yoki dasturni yopganingizda saqlab 

qolinadi. TDBGRID ob’ekti bevosita Datasource xususiyati yordamida 

TDatasource ob’ektga bog`lanadi va shu orqali ma’lumotlarni namoyish etadi. 

 DBText – ma’lumotlar omboridagi matnli maydon ma’lumotlarini chiqarish. 

Ma’lumotlar omboridagi biror maydonni qiymatini namoyish etadigan 

komponenta. 

 DBEdit – ma’lumotlar omboridagi biror maydonni taxrirlash. 

 DBMemo – ma’lumotlar omboridagi memo tipidagi ma’lumotlarni taxrirlash. 

DBImage – ma’lumotlar omborida joylangan OLE tipidagi tasvirlarni o’qish, 

yozish, o’zgartirish va ko’rsatish. 

 DBListBox – ma’lumotlar omboridagi ma’lumotlarni (bittasini tanlab) ro’yxat 

shaklida listga chiqarish. 

 DBNavigator – ma’lumotlar omboridagi yozuvlarni taxrirlovchi komponent. 

Unda yangi so’z qo’shish, o’zgartirish, o’chirish va boshqa bir nechta ishlarni 

qilish mumkin. Bu komponenta orqali jadvaldagi ma’lumotlar 

boshqariladi.TDBNavigator (QDBCtrls) ob’ekti dasturda TDBGRID yoki 

TDBEDIT komponentlai orqali ma’lumotlar ombori yozuvlariga murojaat 

qilinayotga vaqtda qo’llaniladi. TDBNavigator foydalanuvchiga ma’lumotlar 

omboridagi yozuvlarni tahrirlash yoki ko’rib chiqishda qo’l keladi. Foydalanuvchi 

TDBNavigator tugmalardan birini bosganda sha tugma bilan bog`langan amal 
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dasturda bajariladi. Masalan, foydalanuvchi Insert tugmasini bosganda 

ma’lumotlar jadvalida bitta bo’sh qator hosil bo’ladi.  

TDBNavigator tugmalari va ular bajaradigan amallar  

Tugma Amal 

 First  
 Ma’lumotlar omboridagi dastlabki yozuvni faollashtirish.  

U faqat joriy yozuv dastlabki yozuv bo’lmagandagina faol bo’ladi. 

 Prior 
Ma’lumotlar omborida joriy yozuvdan oldingi yozuvni faollashtirish.  

U faqat joriy yozuv dastlabki yozuv bo’lmagandagina faol bo’ladi. 

 Next  
Ma’lumotlar omborida joriy yozuvdan keyingi yozuvni faollashtirish.  

U faqat joriy yozuv oxirgi yozuv bo’lmagandagina faol bo’ladi. 

 Last 
Ma’lumotlar omboridagi oxirgi yozuvni faollashtirish. U faqat joriy 

yozuv  oxirgi yozuv bo’lmagandagina faol bo’ladi. 

 Insert  
Jadvalga ma’lumotlarni kiritish uchun yangi satr qo’shish. Bunda 

satrning ixtiyoriy maydoniga ma’lumot kiritilganda o’zgarishlar 

saqlanadi 

 

Delete  

Joriy yozuvni o’chirish. Bunda yozuvni o’chirish haqida so’rov 

chiqariladi va o’chirilgan yozuv qayta tiklanmaydi. 

 Edit  
Joriy yozuvni o’zgartirish, tahrirlash mumkin bo’lgan holatga 

o’tkazish. 

 Post  
Kiritilgan o’zgaishlarni xotirada saqlash. Bunda joriy maydoning 

oldingi ma’lumotlari o’rniga kiritilgan o’zgarishlar saqlanadi. 

 

Cancel 

Joriy yozuvga kiritilgan o’zgarishlarni bekor qilish. Bu amaldan joriy  

yozuvni almashtirguncha foydalanish mumkin.  
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 DBComboBox-ma’lumotlar omboridagi ma’lumotlarni(ochiluvchi ro’yxat) 

shaklida kombinastiyali tanlash. 

 DBRichEdit – ma’luotlarni taxrirlashning memo ga nisbatan kengrok 

imkoniyati. DBMemo dan farqi RTF formatda bo’ladi. 

 DataSource – Data Access  bulimi komponentasi bo`lib, ma’lumotlarni yoki 

komponentalarni bir-biri bilan bog`lash. Ma’lumotlar manbai bilan ishlash. 

TDATASOURCE ob’ekti bevosita TTable yoki TAdoTablega bog`lanib, 

ma’lumotlar omboridagi yozuvlarni tahrirlash, ularga murojaat qilish imkonini 

beradi. Buning uchun komponentning DataSet xususiyatidagi ro’yxatdan kerakli 

Table elementi tanlanadi va shu orqali ikki ob’ekt birbiriga bog`lanadi. Har bir 

alohida . TDATASOURCE ob’ekti bitta ma’lumotlar omboridagi bitta jadvalga 

ulana oladi. 

Buning uchun quyidagicha kodlar yoziladi: 

begin 

 Table1.DatabaseName:='DBDEMOS'; 

 Table1.TableName:='animals.dbf'; 

 Table1.Active:=True; 

 DataSource1.DataSet:=Table1; 

 DBGrid1.DataSource:=DataSource1; 

end; 

MB jadvali uchun oddiy dastur ilovalarini tuzish. 

Delphi dasturlash vositasida tuzilgan ilovalarni saqlash uchun yuqoridagi tuzilgan 

“Proba” katologida “App” nomli podkatolog tashkil qilamiz. Delphi tizimini ishga 

tushirib, uning komponentalar palitrasi qatoridan Data Accessni ishga tushirib, 
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undan vizual bo’lmagan komponentasi Ttable olinadi (bu komponentani darchaga 

olish uchun u ko’rsatilib sichqoncha chap tugmasini ikki marta tez-tez chiqillatmoq 

kerak bo’ladi). Ttable komponenti ma’lumotlarni saqlash va undan foydalanishda 

ishlatilib, u ma’lumotlarni akslantirishda vizual komponentalar DTBGrid, Tedit va 

boshqalar bilan birgalikda ishlatiladi. 

Ttable komponentasini formaga (darchaga) joylashtirgandan keyin, Object 

Inspectorida uning xossalari quyidagi ketma-ketlikda o’rnatiladi: 

 -Ttable komponentasi ajratiladi (belgalanadi); 

 -DataBase Name MB psevdonimi xossasi o’rnatiladi, Proba psevdonimi 

ro’yxatdan olinadi yoki kiritiladi; 

 -Table Name (MB jadvali nomi) xossasi o’rnatiladi (bu erda MB jadvali 

nomi ro’yxatdan olinadi yoki kiritiladi; 

 -Active xossasi o’rnatiladi (“True” qiymati tanlanadi). 

 Bu bajarilgan buyruqlardan keyin Ttable komponentasi bilan MB jadvali 

orasida aloqa to’liq o’rnatiladi. Ttable komponentasi kabi endi formaga 

TDataSource komponentasini joylashtiramiz. Bu komponenta vizual va vizual 

bo’lmagan komponentalar o’rtasida aloqa o’rnatish uchun xizmat qiladi. Shu 

tufayli TdataSource komponentasiga ma’lumotlar manbai deyiladi. TdataSource 

komponentasi uchun DataSet  (ma’lumotlar to’plami nomi) xossalari o’rnatiladi 

(Table1 nomi olinadi). 

Data Controls menyu qatoridan foydalanib formaga TdbGrid komponentasini 

joylashtiramiz va uning DataSuurce xossasini o’rnatamiz (DataSource1 qiymat 

bilan). Bu TdbGrid komponentasi ma’lumotlar to’plami yozuvlarini jadval 

ko’rinishda akslantirishda xizmat qiladi. 

Ishlab chiqilgan loyixa (loyiha)ni saqlash uchun menyudan quyidagi buyruqlar 

ketma-ket bajariladi. File=>Save Project As. Oldin loyixa formasi (masalan 
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Appl1.pas nom bilan), keyin loyixaning o’zi (masalan Appl.dpr nom bilan) 

saqlanadi.  
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Delphi tizimidan chiqmasdan turib tuzilgan ilovani ishga tushirish uchun F9 

tugmasini bosish kifoya. Ilovani tizimdan tashqarida ishlatish uchun esa oldin 

tizim ichida Ctrl+F9 tugmasini bosish kerak bo’ladi. Bu holda ilovani 

tizimdan tashqarida ishlatish uchun maxsus .EXE kengaytmali fayl avtomatik 

ravishda tashkil etiladi (masalan, Appl.exe). Bu faylni tizimdan tashqarida 

ishlatganda tuzilgan ilova ishga tushadi. Mbga qo’shimcha yozuv kiritish 

uchun oxirgi yozuvga kelib Insert tugmasini bosish, kiritilayotgan yozuvdan 

voz kechish uchun ESC tugmasini bosish, yozuvni to’liq o’chirish uchun esa 

Ctrl+Del tugmasini bosish kerak bo’ladi. 

MB jadvali bilan ishlash uchun oddiy ilova yaratish algortmi quyidagi ketma-

ketlikda bajariladi: 

  1.Delphi tizimi ishga tushirilib BDE komponentalar palitrasidan Ttable 

komponentasi formaga qo’yiladi. 

  2.Formadagi Ttable komponentasi belgilanib, DataBase Name xossasida 

Mbning psevdonimi aniqlanadi. 

  3.TableName xossasidan MB jadvali nomi aniqlanadi. 

  4.Active xossasi True qiymat bilan o’rnatiladi. 

  5.Data Acciss komponentalar palitrasidan TdataSource komponentasi 

formaga qo’yiladi. 

  6.TdataSet xosasi Table1 nom bilan o’rnatiladi. 

  7.Data Controls komponentalar palitrasidan TDbGrid komponentasi formaga 

qo’yiladi. 

  8.DataSourse xossasi DataSourse1 nom bilan o’rnatiladi. 

  9.Menyudan File=>Save Project As buyrug`i berilib, oldin forma keyin 
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loyiha saqlanadi. 

  

  10.Loyihani ishga tushirish uchun F9 tugmasi bosiladi. Natijada quyidagi 

formaga ega bo’lamiz. 

 

TDBNavigator komponenti. MB jadvalida ma’lumotlarni surish, o’chirish, 

yozuvni siljitish va taxrirlash uchun Data Controls komponentalar palitrasida 

maxsus TDBNavigator komponentasi mavjud. 

Bu komponentani formadagi MB jadvaliga quyidagi tartibda o’rnatish 

mumkin. 

  1.MB jadvali formasi ekranga chaqiriladi. 

  2.Data Controls komponentalar palitrasidadan TDBNavigator komponentasi 

formaga joylashtiriladi. 

  3.TDBNavigator komponentalar xossasidan DataSourse xossasi DataSourse1 

nom bilan o’rnatiladi. 

  4.Menyudan File=>Save Project As buyrug`i berilib, oldin forma keyin 

loyiha saqlanadi. 

  5.Loyihani ishga tushirish uchun F9 tugmasi bosiladi. 
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Natijada jadvali ma’lumotlarni surish, o’chirish, yozuvni siljitish va taxrirlash 

kabi tugmachalarga ega bo’lgan quyidagi formaga ega bo’lasiz. 

 

Kompyuter quyidagi dastur kodlarini avtomatik ravishda tuzadi 

unit xodim; 

interface 

uses 

  Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms, 

  Dialogs, StdCtrls, Grids, DBGrids, DB, DBTables, ExtCtrls, DBCtrls; 

type 

  TForm1 = class(TForm) 

    Label1: TLabel; 

    Table1: TTable; 

    DataSource1: TDataSource; 

    DBGrid1: TDBGrid; 

    DBNavigator1: TDBNavigator; 

  private 
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    { Private declarations } 

  public 

    { Public declarations } 

  end; 

var 

  Form1: TForm1; 

implementation 

{$R *.dfm} 

end. 

MB bilan ishlashda Delphi grafikasi 

    MBning jadvali ma’lumotlari asosida grafiklar qurish uchun Delphi 

komponentalar politrasining DataControls sahifachadagi TDBChart 

komponentasi ishlatiladi. Bu komponenta yordamida grafiklar yaratish uchun 

ma’lumotlar manbai, ya’ni MB yaratilgan bo’lishi zarur. Grafik yoki 

gistogrammalar yaratish ketma-ketligi quyidagi qadamlarda bajariladi: 

  1.Ishlab chiqilgan MBning loyiha formasi ekranga chiqariladi. 

  2.TDBChart komponenta formasi asosiy formaga joylashtiriladi. Buning 

uchun TDBChart piktogrammasi sichqonchada ko’rsatilib ikki marta 

chiqillatiladi. 

  3.Grafik redaktori chaqiriladi. Forma sarlovhasi ustiga sichqoncha 

ko’rsatgichini olib kelib ikki marta tez-tez chiqillatiladi yoki o’ng sichqoncha 

tugmachasi bosilib lokal menyudan Edit Chart buyrug`i beriladi. Edit Chart 

redaktorida quyidagi parametrlarni o’rnatish mumkin, ularning tavsifi 

quyidagicha: 
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 Series - bir necha grafiklar variantlarini tavsiya etadi;  

 General - umumiy parametrlarni o’rnatish mumkin, masalan grafik 

ulchamini kattartish (kichraytish); 

 Axis - grafik koordinata o’qlari aniqlaydi; 

 Show Axis - chap, o’ng, past va yuqori o’qlarni tanlaydi; 

 Scales - koordinata o’qi masshtabining xossalari qiymatini aniqlaydi;  

 Automatic - ma’lumotlarni avtomatik masshtablashtiradi;  

         Title - o’qlar bo’yicha matn yozishni aniqlab, uning joylashishini va 

shriftlarini aniqlaydi; 

 Titles - grafik sarlovhasi matnini yozishni aniqlab, uning joylashishi va 

shriftlarini aniqlaydi; 

 Ligent - grafiklarga tushuntirish ma’lumotlarini beradi; 

 Panel - parametrlar panelini joylashtiradi; 

 Paging - ko’p qatorli grafikning parametrlarini aniqlaydi. 

  4.Grafik variantlarini chiqarish va tanlash. Kerakli variantni tanlash, Chart 

sahifasi Series bo’limining ADD tugmachasini sichqonchada chiqillatish bilan 

amalga oshiriladi. Bu oynadagi boshqa tugmachalar vazifalari: 

 Delete - tanlangan joriy variantni o`chiradi; 

 Title - har bir tanlangan variantga sarlovha qo’yishni bajaradi; 

 Clone - grafikdan nusxa tayyorlaydi; 

 Change - joriy variantning turini o’zgartiradi.  
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5.Grafik qurish uchun ma’lumotlar manbai tanlanadi. Buning uchun tanlangan 

variant ikki marta sichqonchada chiqillatiladi va u yerdan DataSaurce 

sahifasiga kirilib, DataSet qatoridan Table1 jadvali tanlanadi. Keyin Tables 

belgisidan (metkasidan) kerakli maydon olinadi va x, u bo’yicha koordinata 

o’qlari aniqlanadi. Close tugmachasi bosilib oyna yopiladi. 

 

  6.Formada grafik joylashtiriladi. 

Misol 1. Funkstiyaning jadval qiymatlari yordamida uning grafigini quring. 

Argument x va funkstiya y qiymatlari quyidagi jadvalda berilgan. 

X 2 3 4 5 6 7 8 9 10 11 

Y 10 15 19 22 25 29 33 38 45 55 

Yechish. 

Argument “x” va funkstiya “y” nomli maydonlardan iborat MBni tuzamiz: 
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1.DataBase DeskTop utilitasini ishga tushiramiz.

 Pusk=>Programmы=>Borland Delphi=>DataBase DeskTop 

  2.DataBase DeskTop oynasining bosh menyusidan quyidagi buyruqni 

beramiz.   File=>Working Directory 

  3.Hosil bo’lgan Set Working Directory muloqot darchaining Aliases idan 

MB psevdonmi aniqlaymiz. 

 

4.Menyudan File=>New=>Table buyrug`ini beramiz. 

  5.Hosil bo’lgan Create Table muloqot darchasidan MB turini aniqlaymiz.  

  6.MB strukturasini tashkil qilamiz. 

 

7.Save As buyrug`ini berib, jadval nomini “fun” deb kiritamiz va Ok tugmasi 

bosamiz. 

  9.Agar MBga ma’lumotlar kiritish kerak bo’lsa DataBase DeskTop oynasi 
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menyusidan File=>Open buyrug`ini berib, keyin faylni tanlab va Edit Data 

tugmachasini bosib ma’lumotlarni kiritamiz. 

 

Table oynasida x va y maydonlariga misolda keltirilgan ularning qiymatlarini 

kiritamiz. Bu qiymatlarni ilova tuzilgandan so’ng kiritsa ham bo’ladi. 

Endi tuzilgan MBni boshqarish uchun ilova yaratishga kirishamiz. 

1.Delphi tizimini ishga tushirib BDE komponentalar palitrasidan Ttable 

komponentasini formaga joylashtiramiz. 

  2.Formadagi Ttable komponentasini uchun, DataBase Name xossasida 

Mbning psevdonimini aniqlaymiz. 

  3.TableName xossasidan MB jadvali nomini aniqlaymiz. 

  4.Active xossasini True qiymat bilan o’rnatamiz. 

  5.Data Acciss komponentalar palitrasidan TdataSource komponentasini 

formaga qo’yamiz. 

  6.TdataSet xosasini Table1 nom bilan o’rnatamiz. 

  7.Data Controls komponentalar palitrasidan TDbGrid komponentasini 

formaga qo’yamiz. 
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  9.DataSourse xossasini DataSourse1 nom bilan o’rnatamiz. 

  9.Label1ga forma sarlovhasini yozamiz.  

  10.Formaga grafikni joylash uchun yuqorida keltirilgan grafikni qurish 

algoritmidan foydalanamiz. 

  9.Menyudan File=>Save Project As buyrug`ini berib, oldin forma keyin 

loyihani saqlaymiz. 

  10.Loyihani ishga tushirish uchun F9 tugmasini bosamiz. Natijada quyidagi 

formaga ega bo’lamiz. 

 

Bu oynada berilgan funkstiyaning jadval qiymatlari o’zgarsa grafik ham mos 

ravishda o’zgaradi. 

Kompyuter quyidagi dastur kodlarini avtomatik ravishda tuzadi 

unit Funk; 

interface 

uses 

Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms, 

  Dialogs, Grids, DBGrids, DB, DBTables, StdCtrls, TeEngine, Series, 

  ExtCtrls, TeeProcs, Chart, DbChart; 
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type 

  TForm1 = class(TForm) 

    Label1: TLabel; 

    Table1: TTable; 

    DataSource1: TDataSource; 

    DBGrid1: TDBGrid; 

    DBChart1: TDBChart; 

    Series1: TFastLineSeries; 

  private 

    { Private declarations } 

  public 

    { Public declarations } 

  end; 

var 

  Form1: TForm1; 

implementation 

{$R *.dfm}                         

  end. 

 

 

 

Xulosa 
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Men xulosa qilib shuni aytamanki, ma`lumotlar bazasi foydalanuvchilarning 

ma’lumotlar omboriga bo’lgan barcha talablarini qondiradi. Shuning uchun 

ma’lumotlar omborini loihalashdan oldin foydalanuvchilarning ma’lumotlar 

omboriga bo’lgan talablarini keng miqyosda o’rganib chiqish zarur. 

Ma’lumotlarning mosligi va ishonchliligini kafolatlaydi. Jadvallarni tuzishda 

foydalanuvchi tomonidan mumkin bo’lmagan ma’lumotlar kiritilashining 

oldini olish uchun ma’lum shartlarni kiritish kerak. Baza- bu jadvallar, 

so`rovlar yig`indisidan tashkil topgan.Jadvallarda ma`lumotlar va ma`lumot 

tiplari joylashadi. So`rovlar esa jadvallarga talablar qo`yadi va ma`lumotlar 

ustida amallar bajaradi. 

Ma’lumotlar omborining maqsadi ma’noga ega bo’lgan ma’lumotlarni bir yoki 

bir nechta joyda ortiqcha sarflarsiz (xotira va zaxiralarni iqtisod qilib) 

saqlashdir. Shunday qilib ma’lumotlar ombori ikkita asosiy maqsadlarni 

ko’zda tutadi: ma’lumotlarni yo’qolishdan saqlash va ularning ishonchliligini 

oshirish.  

Delphi dasturlash tilida ma`lumotlar bazasini tuzish va baza ustida ko`pgina 

amallarni bajarib,ommaga taqdim etish mumkin.Bu uchun juda ko`p 

imkoniyatlar mavjud. 
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